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Preface 

The InRoads Workflow Processes document has been developed as part of the statewide GDOT 

implementation of best practices for MicroStation V8i and InRoads V8i Select Series 2. The intent of 

this document is to provide brief standard workflow processes for use in generating Design Data in 

InRoads V8i Select Series 2. Updates to this document will be made periodically when minor 

revisions, additional information, and/or enhancements are added. 
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Contact Information 

To submit any comments or questions regarding the information contained in this document, please 
contact the Office of Design Policy & Support by email at the following address: 

SolutionsCenter@dot.ga.gov  

In the Email Subject Header, please reference the InRoads Workflow Processes 

file:///C:/Users/C0004035/Desktop/Manuals/InRoads_SDE/SolutionsCenter@dot.ga.gov
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Overview 

The InRoads Workflow Processes document briefly covers common best practice procedures for 

generating Design Data by utilizing InRoads V8i Select Series 2 software.   

For detailed Design Processing instructions please refer to the Training Manual: 

Introduction to InRoads for Design  

Document Content 

Below is a list of topics covered in this document: 

 Process to create a Staging Surface

 Process to use the InRoads Sight Visibility Tools

 Process to create Driveway Profile Sheets

 Process to Export InRoads Surface Data to LandXML

 Process to Export InRoads Geometry Data to LandXML

 USACE 404 Permit Procedure For Perennial Streams – Culverts

 Process to display Subsurface Utilities (SUE) on Cross Sections

.
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 Process to Create a Staging Surface  

Objective: The following process consists of merging a Proposed Staging DTM file (Design surface) 

with the Existing surface DTM file (Original Surface).  The command Surface  Edit Surface  

Merge Surfaces… is used to accomplish this.  The construction limits of the Design surface define 

the exterior boundary of the Design surface.  Features within this boundary are deleted from the 

Original surface and create a ‘hole’ in the Original surface.  The Design surface is copied into this 

hole and the resulting merged surface is saved to the Destination Surface. The following methods 

and steps may vary slightly depending on the staging in question – but the overall process remains 

the same.  IMPORTANT:  Create a backup of the project files before creating/making any changes 

to the DTM surfaces. 

Requirements: You must have a minimum of two surfaces, an Original surface and a Design surface.  

The Original surface is typically the Existing surface supplied by the SDE (i.e. PI#_Exist.dtm) and the 

Design surface is the first stage surface created by the designer. 

Procedure: 

1. In InRoads, select Surface  Edit Surface  Merge Surfaces… 
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2. In the Merge Surfaces dialog, match the following settings and select the Original surface 

and Design surface and Key-in a name for the Destination surface.  It is recommended to 

name the Destination surface with a combination of the Original surface name and the Design 

surface name. This helps in remembering how the surface was created.  In the example 

shown below the Original surface is named 1234567_Exist and the Design surface is named 

DE1_STAGE1.  The destination surface was named EXIST_DE1_STAGE1. 

 

PLEASE NOTE: 

 If only the Existing surface is to be depicted in the Cross Sections for the Stage 1 surface, 

un-select all Surface Features shown in blue above and make sure that only the “Included 

Design Surface Features” of the Style named Main_P_Transverse Features are selected 

(highlighted in Blue).  

 If all Features are highlighted and selected, this will depict all of the components when 

cross sections are created. 

3. Next, click Apply. 
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4. If the following error message appears click OK.   

 

5. The Destination surface may now be used as the Original surface for Stage 2 Design and 
the above steps may be repeated for additional stages. 

6. As a last step, in order to change the surface to the correct “Existing” symbology – perform 
the following steps: 

1) In InRoads, Select SurfaceSurface Properties from the InRoads Menu and the 
Surface Properties dialog box will appear. 

2) Click on the Advanced Tab (at the top of the Surface Properties dialog box.). 

3) In the Surface: Pull-down – Ensure the Exist staging surface is selected. 

In the Cross Sections frame: 

 In the Symbology: Pull-down – select EXISTING 

In the Profiles frame: 

 In the Symbology: Pull-down – select EXISTING 
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Additional Information Concerning the Check Boxes 

Retain All Original Surface Points - controls whether or not to include in the Destination surface those 

features from the Original surface that lie within the perimeter of the Design surface 

Retain Features Excluded from Triangulation - controls whether or not to include in the Destination 

surface those features from the Original surface that lie within the Design surface perimeter and that 

are marked to be excluded from triangulation. This option is relevant only when the Retain All Original 

Surface Points option is off.  To delete all the features in the Original surface that fall within the bounds 

of the Design surface perimeter, turn off both this option and the Retain Features Excluded from 

Triangulation option. 

Merge Selected Areas from Original - if selected, after merging the Original and Design surfaces into 

the Destination surface, Merge Surfaces scans the active selection set for closed shapes.  For each 

located closed shape the contents of the Destination surface inside the shape are deleted. Then the 

contents of the Original surface inside the shape are copied to the Destination surface.  If Add Design 

Surface Edge as Breakline is turned on, boundary features are added for each selected shape. 

Add Design Surface Edge as Breakline - adds the perimeter of the Design surface to the Destination 

surface as a breakline. This ensures that the triangles imported from the Design surface have roughly 

the same configuration in the Destination surface. 
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 Process to Utilize the InRoads Sight Visibility Tools  

Objective: The following process describes the use of the Sight Visibility Tools. The Sight Visibility 

Tools consist of the Roadway Visibility Tool and the Surface Visibility Tool.  The Roadway Visibility 

Tool evaluates the sight distance along a roadway.  The Surface Visibility Tool evaluates the sight 

distance on a surface along a user defined sight line or a user defined radial region from a user 

defined location. It’s important to note that the accuracy of your results is only as accurate as your 

model.  If buildings, guardrail, walls, trees, signs, etc. are not in your model, your results will not report 

failures due to these obstacles.  

Requirements:  A horizontal alignment and a Design surface that has been merged with an Existing 

surface are required to use these tools.  

NOTE: Please see the Workflow Process (WF 2) instructions in the previous sections for the 

procedure on merging Existing and Proposed surface(s). 

Procedure: 

1. The Sight Visibility Tools are an application add-in that must be added to the InRoads main 

menu. 

a. In InRoads, select ToolsApplication Add-ins. 

b. Toggle on the ‘Sight Visibility Add-in’ and click OK. 

c. The Sight Visibility Tools are added to the Evaluation menu. 

2. The Roadway Visibility Tool: 

a. In InRoads, select EvaluationSight VisibilityRoadway Visibility. 

b. Load the Preference named ‘Roadway Visibility’.  The Roadway Visibility Preference loads 

the display symbology, an eye height of 3.5’ and an object height of 2.0’ as well as other 

settings to simplify the use of the tool. 

c. Select the General leaf.  

i. In the Surfaces field, select the merged surface. 

ii. In the Horizontal Alignment field, select an alignment. 

iii. Enter the Start Station and Stop Station for the range to be analyzed. 

iv. Enter an Interval value.  The Interval value is the distance that sight calculations are 

made. 

v. Enter a Sight Distance value.  The Sight Distance is the desired sight distance for the 

roadway. 

vi. Enter a Relaxed Distance value. The Relaxed distance is the minimum allowable 

sight distance. This value can be the same as the Sight Distance value. 

d. Select the Positions leaf. 

i. Enter the Offset value from the alignment for the driver’s Eye Position.  This value 

should be calculated for the worst case scenario which is typically the driving lane on 
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the inside of the curve. A negative value is to the left and a positive value is to the 

right. 

ii. Enter the Offset value from the alignment to the Object Position.  This value should 

be calculated for the worst case scenario which is typically the driving lane on the 

inside of the curve.  A negative value is to the left and a positive value is to the right. 

e. Click Apply. A report will be displayed listing sight distance at each interval and graphics 

will be displayed at each interval representing sight visibility. 

i. A green line meets or exceeds the Sight Distance. 

ii. A yellow line meets or exceeds the Relaxed Distance. 

iii. A red line does not meet either the Sight Distance or the Relaxed Distance. 

 

3. The Surface Visibility Tool  

a. If the Surface Visibility Tool is going to be used to analyze an Intersection it is 

recommended to calculate and draw the Intersection Sight Triangle(s) in MicroStation.  

The sight triangle(s) will provide a reference for when the graphics are displayed from the 

Surface Visibility Tool. 

b. In InRoads, select EvaluationSight VisibilitySurface Visibility. 

c. Load the Preference named ‘Surface Visibility’.  The Surface Visibility preference loads 

the display symbology, an eye height of 3.5’ and an object height of 2.0’ as well as other 

settings to simplify the use of the tool. 

d. Select the General leaf. 

i. In the Surfaces field, select the merged surface. 

ii. Select the desired Mode from the drop down menu.  There are three modes for this 

tool:  Surface Points, Surface Regions, and Line of Sight. 

1. The Surface Points mode indicates what triangle vertices can be seen from the 

observation point.  Green points are drawn radially from the eye position at vertices 

that can be seen and red points are drawn at vertices that are obstructed. 
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2. The Surface Regions mode draws lines radially from the observation point.  The 

lines that are drawn display in green where the sight is clear and in red where the 

sight is obstructed. 

 

3. The Line of Sight mode draws a line between two user defined locations.  One 

location being an object and the other location being the driver’s eye.  The line that 

is drawn displays in green where the sight is clear and in red where the sight is 

obstructed. 

 

iii. Use the locate button to select the Northing and Easting for the Eye Position. 

iv. The Drape Surface is by default toggled on.  When the Drape Surface is toggled on, 

the elevation is calculated as 3.5’ above the surface at the specified location. 

e. Select the Surface Points leaf.  The settings on this leaf are only required if the mode is 

set to Surface Points on the General leaf. 
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i. The Object Height is toggled on by default with a value of 2.0’which was obtained 

from the AASHTO Green Book for checking stopping sight distance. 

ii. The Sight Distance is toggled off by default which results in the entire surface being 

evaluated. This box may be toggled on and a value entered to limit the distance being 

checked. 

iii. Click Apply. 

f. Select the Surface Regions leaf.  The settings on this leaf are only required if the mode 

is set to Surface Regions on the General leaf. 

i. In the Method area, select either the Radial Angle Interval or the Number of Radials. 

1. The Radial Angle Interval species the angle at which lines of sight will be 

generated from the eye position. 

2. The Number of Radials specifies the number of lines of sight that will be 

generated from the eye position. 

ii. The Object Height is toggled on by default with a value of 2.0’which was obtained 

from the AASHTO Green Book for checking stopping sight distance. 

iii. The Sight Distance is toggled off by default which results in the entire surface being 

evaluated. This box may be toggled on and a value entered to limit the distance being 

checked. 

iv. Click Apply. 

g. Select the Line of Sight leaf.  The settings on this leaf are only required if the mode is set 

to Line of Sight on the General leaf. 

i. Enter the Northing and Easting coordinates of the object by using the locate button.  

The line of sight will be defined by a line drawn from the eye position (on the General 

leaf) to the Object Position. 

ii. With the Drape Surface toggled on, the base elevation for the Object Position is set 

to the surface (on the General leaf) at the specified location. 

iii. The Object Height is toggled on by default with a value of 2.0’which was obtained 

from the AASHTO Green Book for checking stopping sight distance. 

iv. Click Apply. 
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 Process to Create Driveway Profile Sheets  

Objective: The following process consists of a method to generate Driveway Profile Sheets. This 

method is provided as an alternative to the traditional method of generating custom cross sections at 

driveway stations.    

Requirements: You must have an Existing DTM surface as well as horizontal and vertical 

alignment(s) stored for the driveway(s). 

Procedure: 

1. Before beginning, determine the active scale in MicroStation.  This can be accomplished by 

using the key-in window to enter AS= and then hit the enter button on your keyboard.  The 

scale will be displayed on the bottom bar in your MicroStation window.  Remember this value 

by writing it down somewhere.  You will need to return MicroStation to this scale later. 

2. The active scale in MicroStation needs to be 50 to place the grid at the proper size to work 

with InRoads.  This can be accomplished by using the key-in window to enter AS=50. 

3. Using MicroStation, place the cell GPLN. (Located in the cell library GDOT-GN-Sheets.cel) 

4. Using the MicroStation GDOT Tools menu, set the Driveway Profile levels. (Located in 

Section 17). 

5. Now that the grid is placed, use the key-in window to return the active scale to the original 

value determined in the First Step. 

6. Now in InRoads, set the Existing ground DTM for your project as the active DTM. 

7. Set the horizontal and vertical alignment of the Driveway active. 

8. Ensure the Global Scale Factor in InRoads is set to  50 

9. Select Evaluation  Profile  Create Profile 

a. Preferences = Driveway Profiles 

b. General Tab - check appropriate Existing ground surface. 

c. Optional: Controls Tab - Set desired Station range.  The length of the grid is determined 

by the length of the active horizontal alignment which may be longer than the profile and 

therefore longer than necessary. 

d. Axes-Left  Enter Driveway profile name and/or description in the Title – Text: field.  

Shown below. 
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10. Click Apply and place the profile using the intersection snap in MicroStation and selecting the 

intersection of two of the blue lines in the profile grid as shown below. 

 

11. Once placed, the profile should look similar to that shown below.  Notice the location of the 

Driveway Description. 
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12. Evaluation  Profile  Annotate Profile. 

a. Preference = Driveway Profiles.  When applied the Existing and Proposed elevations of 

the driveway will display as shown below.  With the Existing in green and the Proposed in 

red as shown here. 

 

13. Geometry  View Geometry  Vertical Annotation. 

a. Preferences = GDOT Profiles.  When applied the vertical curve information will be 

displayed as shown below. 
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14. Repeat the above steps as necessary to place additional driveway profiles. 
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 Process to Export InRoads Surface Data to LandXML  

Objective: The following process is used to export Existing and Proposed InRoads DTM surfaces 

from an InRoads format to a standardized LandXML format.  The InRoads Existing and Proposed 

DTM surfaces (in .XML format files) can then be uploaded for use by other users in the Construction 

and Design industries as well as for use in automated machine guidance equipment.    

Requirements: You must have an InRoads Design ALG file, Existing DTM surface and Proposed 

(Finished) DTM surface file(s). The LandXML Translator is then utilized to select the Existing and 

Proposed surface(s) which will be exported out in order to create the XML File(s).  

Procedure: 

A. Open the Geometry Project (.ALG) in InRoads 

1. In InRoads, select File  Open 

2. Set the Files of type:  Geometry Projects (*.alg) 

3. Select the .ALG File (Geometry Project) that contains the Cogo Points and Alignments. 

B. Open the DTM Project File(s) (.DTM) in InRoads 

1. In InRoads, select File Open 

2. Set the Files of type:  Surfaces (*.dtm) 

3. Select the .DTM File(s) for the Existing surface and any Proposed (Finished) surfaces.   

C. Create the LandXML File for the Existing surface 

1. In InRoads, select File TranslatorsLandXML Translator 

2. Select the Export Surface tab 

3. Highlight the Existing surface to export in the Surfaces: list. 

4. Click the check boxes for the following:  

 

5. Linear Units: US Feet 

6. State: existing 

7. Click the Save As button. The Export dialog opens. Key in the File Name: and click 

Save. 

8. In the File Name: field - the name of the file will be listed. 

9. Ensure your dialog box is similar to the one depicted below: 
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10. Next, click Close to close the dialog box. 

11. The LandXML file will be created in the Path depicted in the File Name: field. 
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D. Create the LandXML File for the Finished (Proposed) Surfaces 

1. In InRoads, select File TranslatorsLandXML Translator 

2. Select the Export Surface tab 

3. Highlight the Proposed surface to export in the Surfaces: list. 

4. Click the check boxes for the following:  

 

5. Linear Units: US Feet  

6. State: proposed 

7. Click the Save As button. The Export dialog opens. Key in the File Name: and click 

Save. 

8. In the File Name: field - the name of the file will be listed. 

9. Ensure your dialog box is similar to the one depicted below: 
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10. Next, click Close to close the dialog box. 

11. The LandXML file will be created in the Path depicted in the File Name: field. 

12. Repeat the above Steps 1-11 for any additional Finished DTM surfaces. 
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 Process to Export InRoads Geometry Data to LandXML  

Objective: The following process is used to export Geometry Data such as COGO Points, 

Horizontal/Vertical Alignments, etc. from an InRoads format to a standardized LandXML format.  The 

InRoads Geometry Data (in .XML format files) can then be uploaded for use by other users in the 

Construction and Design industries.      

Requirements: You must have an InRoads Design ALG file which contains the COGO Points and 

Horizontal/Vertical Alignments to export the data. The LandXML Translator is then utilized to select 

the Geometry data which will be exported out in order to create the XML File(s).   

Procedure: 

A. Open the Geometry Project (.ALG) in InRoads 

1. In InRoads, select FileOpen 

2. Set the Files of type:  Geometry Projects (*.alg) 

3. Select the .ALG File (Geometry Project) that contains the Cogo Points and Alignments 

that are to be exported to the LandXML file. 

B. Create the LandXML File 

1. In InRoads, select File TranslatorsLandXML Translator 

2. Select the Export Alignment tab 

3. Select the Geometry Project: 

4. Click in the Include: field to activate the Filter button 

5. The Geometry Selection Filter dialog box opens. Select all of the Alignments that are to 

be included in the XML file. Then click OK. 

6. Ensure that LandXML: Version 1.0 is selected. 

7. Check the box to “Include All Cogo Points”.  

Note: This box can be left unchecked if no Cogo Points need to be included in the 

LandXML file. 

8. Important - Change the Linear Units to: US Feet 

9. Change the State: to  proposed 

10. Click the Save As button. The Export dialog opens. Key in the File Name: and click 

Save. 

11. In the File Name: field - the name of the file will be listed. 

12. Ensure your dialog box is similar to the one depicted below: 

Note: If the LandXML file is written by Survey, the ALG file Name will be PI#_SDE. 

    If the LandXML file is written by Design, the ALG file Name will be PI#_Design. 

13. Next, click Close to close the dialog box. 
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14. The LandXML file will be created in the Path depicted in the File Name: field. 
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 USACE 404 Permit Procedure for Perennial Streams - 
Culverts 

General Information: 

In order to conform to the United States Army Corps of Engineers (USACE) 404 Permit requirements 

for Perennial Streams – Culverts, GDOT has established the following standards and workflow 

procedures for incorporating the survey data into the InRoads Survey/Design Software. For new 

proposed culverts and for existing culvert replacements over Perennial Streams, the Designer will 

receive an updated Survey of the area provided in a Digital Terrain Model format. This area of survey 

will encompass 100 feet upstream from the end of proposed or replacement culvert and 100 feet 

downstream from the end of proposed or replacement culvert for a total minimum coverage of 200 

feet. This DTM will contain stream cross section points identified by an Ecologist. The Designer will 

create stream cross sections at these locations.  The DTM will also contain stream bank-full 

information that will be plotted on both the stream cross sections and the steam profile. These stream 

cross section and profile deliverables will be provided to the ecologist for his/her use in preparing the 

404 Permit.    

Feature Styles for Stream Bank-Full and Stream X-Sections 

Feature Style Description Type 

 TOPO_E_SBF  Stream Bank-Full  3D – Non-Triangulated 

 TOPO_E_SXS  Stream X-Section  3D – Non-Triangulated 

 

Workflow Procedure: 

The Perennial Stream field survey data will be provided in a .DTM file format. If there are multiple 

culverts on the project, a .DTM file will be provided for each culvert area.  

 NEVER merge the 404 Permit DTM Data into the original DTM containing the Existing 

Surface. 

Standard File Naming Conventions: 

   ** File Type File Name 

  
DTM – Field Survey for Perennial Streams 

 

1st  404 Permit DTM 

2nd 404 Permit DTM   

3rd 404 Permit DTM, Etc. 

  

 

PI#CA_404 Permit.dtm 

PI#CB_404 Permit.dtm 

PI#CC_404 Permit.dtm, etc. 
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Key To Naming Conventions: 

File Name File Denotation 

 1234567CA_404 Permit 1234567=         PI Number 
CA =                  Culvert Location A 
404 Permit =   Type of Surface 

 

 1234567CB_404 Permit 1234567=         PI Number 
CB =                  Culvert Location B 
404 Permit =   Type of Surface 

 
 

Workflow Steps: 

The following procedure contains a brief outline of the processes used to create a stream profile and 

stream cross sections. For Detailed information regarding the creation, generation and review of 

InRoads information - please see the Introduction to InRoads_Design Training Material located on 

the GDOT web page at the following link: 

http://www.dot.ga.gov/PartnerSmart/DesignSoftware/INROADS/Introduction%20to%20InRoads_De

sign.pdf 

1. Open the Design ALG file and the 404 Permit DTM. 

2. Display the feature(s) with the feature style TOPO_E_DSC (stream center).  This can be 

accomplished using the command Surface  View Surface  Features. 

3. If there are any gaps, connect them using the Place Line command in MicroStation. 

4. Use the Steam Center graphics to create a stream center alignment in the ALG. The command 

File  Import  Geometry-From Graphics with a feature style of DRNG_P_DITCH can be 

used to accomplish this.  An alignment is required in order to generate a stream profile and 

stream cross sections. 

5. Display the new alignment and its stationing.  A preference named ‘USACoE_404_Permit’ 

has been setup and may be used to improve the appearance of the stationing. 

6. Display the location of the stream bank full points, identified by the Ecologist, by selecting 

Surface  View Surface  Features and selecting the feature style TOPO_E_SBF.  The 

stream bank full points should display as purple squares. 

7. Display the location of the stream cross section points identified by the Ecologist by selecting 

Surface  View Surface  Features and selecting the feature style TOPO_E_SXS.  The 

stream cross section points should display as blue crosses and are where the Ecologist has 

determined stream cross sections will be generated by the Designer. 

8. Display the location of the stream elevation points by selecting Surface  View Surface  

Features and selecting the feature style TOPO_E_DWE.  The stream elevation points should 

display as upside down blue triangles. 

http://www.dot.ga.gov/PartnerSmart/DesignSoftware/INROADS/Introduction%20to%20InRoads_Design.pdf
http://www.dot.ga.gov/PartnerSmart/DesignSoftware/INROADS/Introduction%20to%20InRoads_Design.pdf
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9. Create a Stream Profile using the command Evaluation  Profile  Create Profile and 

loading the preference named ‘USACoE_404_Permit’.  Ensure the stream alignment created 

previously is the active alignment and the global scale factor is set to 50. 

10. Display the stream bank full profile on the stream profile using the command Evaluation  

Profile  Update Profile. Select the Projected Features leaf and check the ‘Display On’ radio 

button. Highlight the 404 Permit DTM in the surfaces field and highlight the feature style 

TOPO_E_SBF then click Apply. A purple line with squares at the vertices should display 

representing the stream bank full. 

11. Turn off the display of the existing ground in the stream profile by selecting Evaluation  

Profile  Update Profile. Select the Surface leaf and check the ‘Display Off’ radio button. 

Highlight the 404 Permit DTM and click Apply.  The display of the existing ground (green 

dashed) should turn off. 

12. Turn on the display of the stream center profile by selecting Evaluation  Profile  Update 

Profile.  Select the Projected Features leaf and place a check in the ‘Display On’ radio button.  

Highlight the 404 Permit DTM and highlight all the features with the features style 

TOPO_E_DSC and click Apply.  The stream center profile will display as a blue dot-dashed 

line with blue circles at the vertices.  The elevations of this stream profile will match the 

elevations of the existing ground that was previously turned off but will now be displayed with 

the correct symbology. 

13. Turn on the display of the stream cross section points by selecting Evaluation  Profile  

Update Profile.  Select the Projected Features leaf and place a check in the ‘Display On’ 

radio button.  Highlight the 404 Permit DTM and highlight all the features with the features 

style TOPO_E_SXS and click Apply.  The locations of the stream cross sections will be 

identified by a blue cross. 

14. Turn on the display of the locations where water elevations were surveyed by selecting 

Evaluation  ProfileUpdate Profile.  Select the Projected Features leaf and place a check 

in the ‘Display On’ radio button.  Highlight the 404 Permit DTM and highlight all the features 

with the feature style TOPO_E_DWE (Drainage Top of Water Elevation) and click Apply. 

15. Use MicroStation to include the profile title, legend and cross section stations as shown below. 
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16. Create custom stream cross sections using the command Evaluation  Cross Section  

Cross Sections and loading the preference named ‘USACoE_404_Permit’.  Select the 

Custom leaf and set the type to Perpendicular. Set the Left and Right offset to -20 and 20.  

Use the Station Locate button and snap to the blue crosses in the plan view to select a cross 

section station and then click the add button.  Continue doing this until all cross section 

stations have been selected and added.  Save the custom cross sections by clicking the Save 

As button. Set the Global Scale Factor to 10 and then click Apply to generate the cross 

sections. 

17. Use MicroStation to draw and label the Bank-full and Water Level Elevations as shown in the 

example screen capture below.  These elevations may be determined as best as possible 

from the Stream profile generated previously. 
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18. Use the GDOT Tools in MicroStation to create PDF files of the Stream Profile and Stream 

Cross Sections as shown below for submittal to the Ecologist. 
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 Process to Display Subsurface Utilities (SUE) on Cross 
Sections  

Objective: The recommended procedure for displaying SUE data on the cross sections is to create 

custom cross sections only at the stations where SUE data is located.  The State Utilities Office and 

the SUE Consultant will stand by this data.  This process is depicted in Method 1. 

An alternative method of displaying SUE data on the cross sections is to chain together the points 

collected by the SUE Consultant, which allows the SUE data to be displayed at desired intervals.  

This practice is NOT recommended and you are highly encouraged NOT to adopt this practice.  

The State Utilities Office and the SUE Consultant will NOT stand by the interpolated data resulting 

from this practice in Method 2.  If Method 2 is used, the following note must be placed on each cross 

section sheet where this interpolated information is shown: 

NOTE:  The grade of the existing utilities shown on the cross sections on this sheet has been derived 

from interpolated data and is not accurate.  This interpolated information should not be used for 

design or relocation purposes. 

While the second method is not recommended, this document provides instructions for both methods. 

Requirements: You must have a field surveyed CSV file (PI#_SUE.csv).  This file is provided by the 

State Utilities Office as part of the subsurface utilities deliverables.  Additional files you will need are 

the Original Ground surface (i.e. PI#_Exist.dtm), the Designer’s geometry file (i.e. PI#_Design.alg) 

and the Designer’s finished surface (.dtm) for the corridor that the subsurface utilities are to be 

displayed in. 

Procedure: 

METHOD #1: Custom Cross Sections 

1. Create an InRoads survey field book (.FWD).  This file is used to import and process the raw 

field survey data in the CSV file.  This file is not normally seen or used by the Designer but is 

required to import and process the PI#_SUE.csv file. 

a. In the InRoads workspace bar, make the Survey tab the active tab.  

b. In InRoads, select File  New 

c. Click on the Survey Data tab to make it the active tab. 

d. In the Name: field key-in PI#_SUE. 

e. Click Apply & Close. 

f. You should now see the new Survey Data file listed in the InRoads workspace bar. 

g. Even though the Survey Data file is listed in the InRoads workspace bar, the file has not 

yet been saved.  Save the file by selecting File  Save  Survey Data and naming the 

file PI#_SUE.fwd. 

2. Import the PI#_SUE.csv file. 

a. In InRoads, select File  Import Survey Data 

b. In the Import dialog, set the Files of type: to GDOT Trimble Format (*.csv). 

c. Navigate to and select the PI#_SUE.csv file. 

d. Click Import and Close.  
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3. When importing field survey, the InRoads field book automatically displays the planimetrics. 

Turn off the display of the planimetrics by clicking Survey View Survey Data and 

unchecking Planimetrics as shown below. 

 

4. While much can be done with the InRoads field book, its only purpose by Design for 

subsurface utilities is as a repository to import the survey data and export it to an InRoads 

DTM.  To do this, a new DTM surface named PI#_SUE.dtm must be created. 

a. In the InRoads workspace bar, make the Surfaces tab the active tab. 

b. In InRoads, select File  New 

c. Ensure the Surface tab is the active tab. 

d. In the Name: field key-in PI#_SUE. 

e. If desired, enter a Description. 

f. Click Apply & Close. 

g. You should now see the new Surface file listed in the InRoads workspace bar. 

h. Even though the Surface file is listed in the InRoads workspace bar, the file has not yet 

been saved.  Save the file by selecting File  Save  Surface and naming the file 

PI#_SUE.dtm 

5. Export the survey data from the PI#_SUE.fwd InRoads field book to the PI#_SUE.dtm surface. 

a. Ensure the PI#_SUE.dtm surface is the active surface.  There should be a red square 

next to the surface name in the InRoads workspace bar. 

b. In InRoads, select Survey  Survey Data to Surface… 

c. Verify that the surface name reads PI#_SUE. 

d. Click the Preferences button and load the preference named GDOT. 

e. Click the Filter button and select the filter named DTM Surface Codes. 

f. Click OK to close the Survey Style Filter dialog. 

g. Click OK in the Survey Data To Surface dialog. 
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h. In the Triangulate Surface dialog click Apply & Close.  Although no SUE data will be 

triangulated, this step must be performed to prevent error messages from appearing when 

you display the surface features on the cross sections. 

i. Save the changes by selecting File  Save  Surface. 

6. Review the subsurface utilities in the PI#_SUE.dtm. 

a. In InRoads, select Surface  Feature  Feature Properties. 

b. In the Feature Properties dialog, review the Feature Names, Styles and Descriptions.  

The SUE Consultant has entered Descriptions for the Test Hole number, conflict number 

(if available), and utility so that the designer can associate the feature name with 

information in the Utility Impact Analysis (UIA) spreadsheet provided by the State Utilities 

Office. (Please note that a UIA is not provided on all projects; therefore, a conflict number 

may not be part of the description provided in the CSV file by the SUE Consultant.)   

c. Click Close to exit the Feature Properties dialog. 

7. View the subsurface utilities. 

a. In InRoads, select Surface  View Surface  Features… 

b. In the View Features dialog, ensure all features are highlighted in blue and click Apply & 

Close.  The top of the ‘SUE’ utilities are represented by an inverted green triangle with 

the text SUE inside.  You may have to turn off fill in the view attributes in MicroStation to 

see the text.  If the bottom of the ‘SUE’ utilities were collected, it is represented by a red 

triangle with the text ‘SUE’ inside. 

 

 

 

 

 

8. Display and Station the roadway centerline alignment from which the cross sections are to be 

built. Ensure this alignment is the active alignment.  Displaying this alignment will be useful in 

later steps. 

9. Create Custom Cross Sections 

a. Set the InRoads snap mode to No Snap.    

b. Set the Global Scale Factors to 10.0. 

c. Select Evaluation  Cross Section  Cross Sections 

d. Load the appropriate preference (‘Narrow 10h 10v’ or ‘Wide 10h 10v’). 

e. In the Cross Sections dialog, under the General leaf, ensure the Existing Ground 

Surface, Finished Surface and the new SUE Surface DTM’s are checked as shown below. 
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f. Still in the Create Cross Section dialog, make the Custom leaf the active leaf. 

g. In the Type: field, change type to Perpendicular. 

h. In the Features field, place a check in the Projected check box.  The Crossing Feature check 

box only works on breakline features and will not work on individual points even if the point is 

directly on the alignment. 

i. Enter in an Ahead Band and a Back Band of 1.0. 

j. In the Details field, change both the Left Offset: and Right Offset: to either 80.0 or 140.0 

depending on whether the Narrow or Wide preference was loaded in Step 9d. 

k. Next to the Station: field, click the Locate button   and move your mouse over the 

MicroStation screen and key point snap to the origin of a SUE cell and then left click to accept.  

The station of the utility will be returned to the Station: field. 

**NOTE:  The origin of the SUE top cell (Green Inverted Triangle) is the bottom point.  The origin 

of the SUE bottom cell (Red Triangle) is the top point. 
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l. Click Add to add the station to the Custom List. 
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m. Repeat steps j & k until all SUE utilities have been added to the Custom List. Your list 

should look similar to that shown here when finished. 

 

n. Before continuing, save your Custom Cross Section List by clicking the Save button and 

saving an XSC file.  This can be used later if you need to recreate your Custom Cross 

Sections. 

o. Click Apply but do not close the Cross Sections dialog.  The SUE utilities should be 

displayed on the cross sections similar to that shown below. 

  



InRoads Workflow Processes SS2   
 

 

Rev 2.0                                                                   7. Process to Display Subsurface Utilities (SUE) on Cross Sections 

8/2/17                                                                                                                                                                     Page 7-7 

**NOTE: The top of the SUE utility is represented by a green inverted triangle with the origin 
at the bottom point.  If collected, the bottom of the utility is represented by a red triangle with 
the origin at the top point. 

 

10. If desired, the SUE utility can be annotated. 

a. If not still open from the previous step, select Evaluation  Cross Section  Cross 

Sections to open the Cross Sections dialog. 

b. Click the Annotate Cross Section folder and select the General leaf. 

c. Load the preference named (‘XSEC TEXT - SUE’) 

d. Place a Check in the Check Box next to the Surface PI#_SUE and click Apply. 

  



InRoads Workflow Processes SS2   
 

 

Rev 2.0                                                                   7. Process to Display Subsurface Utilities (SUE) on Cross Sections 

8/2/17                                                                                                                                                                     Page 7-8 

e. Each of the SUE utilities should be annotated as shown below.  

PLEASE NOTE: At the time of this writing a bug in the InRoads software may prevent the 

PI#_SUE surface from appearing under the Annotate Cross Section Surfaces list. If this 

surface is missing from the list in the Cross Sections dialog, close the Cross Sections 

dialog and reopen it and the surface will appear in the list. Then repeat Steps b – d to 

annotate the cross sections. 

**NOTE: All annotation will be displayed on the level XSEC_E_SUETOP-Text regardless 

of whether or not the utility represents the top or bottom of the utility. 

 

f. Close the Cross Sections dialog. 

11. This completes this workflow process for Method #1. 
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METHOD #2: Chain together points to display Subsurface Utilities at regular intervals 

1. Create a copy of the PI#_SUE.csv file received from the State Utilities Office and name it 

PI#_SUE_Chains.csv. 

2. Open the PI#_SUE_Chains.csv file in a text editor and review it.  This file is a comma delimited 

text file in the format shown below. It is created by the SUE Consultant for import into InRoads 

and in its current state will only import in as points. As such it requires editing by the Designer 

in order to import in as chains with the understanding that the Survey entity is not responsible 

for any data interpolated between the points. 

Point                                                                         Feature        InRoads              

No.     | Northing         | Easting             | Elev.    | Code          | Functionality  | Description                              

6118,1571994.611,2075443.620,1009.0,SUETOP1,ATTRNAME,"TH36 C96 8.5""PVC W" 

6128,1572076.402,2075424.612,1008.0,SUETOP2,ATTRNAME,"TH41 C110 8.5""PVC W" 

6126,1571817.716,2075529.155,1008.5,SUETOP2,ATTRNAME,"TH42 C111 8.5""PVC W" 

6216,1571697.883,2075595.682,1020.4,SUETOP2,ATTRNAME,"TH43 C112 8.5""PVC W" 

6618,1571598.974,2075614.690,1020.6,SUETOP2,ATTRNAME,"TH44 C113 8.5""PVC W" 

6238,1572017.436,2075527.254,1019.0,SUETOP3,ATTRNAME,"TH124 C299 13""DIP W" 

6234,1571720.708,2075654.606,1019.2,SUETOP3,ATTRNAME,"TH125 C301 13""DIP W" 

6289,1571564.736,2075728.737,1019.4,SUETOP3,ATTRNAME,"TH126 C303 13""DIP W" 

6291,1571137.119,2076073.372,1019.6,SUETOP3,ATTRNAME,"TH127 C304 2.5""DBC T 13""DIP W" 

62910,1570443.921,2076674.042,992.0,SUEBOT3,ATTRNAME,"TH127 C304 2.5""DBC T 13""DIP W" 

 

3. To edit the CSV file to import in as chains, the Feature Codes representing a chain must be 

identified. For an item to be a chain there must be at least 2 points.  In the example above, 

SUETOP1 cannot be changed to a chain because there is only a single instance of SUETOP1.  

The same is true for SUEBOT3.  Only SUETOP2 and SUETOP3 can be made chains. 

4. Now that the Features that can be made into chains have been identified, the starting point 

for each feature to be chained must be identified.  The first Feature Code number encountered 

is the starting point for each Feature. In the example above, point 6128 is the starting point 

for the Feature SUETOP2 and point number 6238 is the starting point for the Feature 

SUETOP3. 

5. Now that the Features that can be chained have been identified and the starting point for each 

chain has been identified - it is time to edit the Features so they will be chained together when 

they are imported into InRoads.  To do this, a start command must be appended to the Feature 

Code.  The start command is ST and is separated from the Feature Code by a single space. 

When the CSV file is imported, InRoads will read this command and chain together each point 

with an identical Feature Code.  In the example below, two chains will be created, SUETOP2 

and SUETOP3.  Review the line for point numbers 6128 and 6238 which have been edited to 

include the start command ST.   
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Point                                                                         Feature        InRoads              

No.     | Northing         | Easting             | Elev.    | Code          | Functionality  | Description                              

6118,1571994.611,2075443.620,1009.0,SUETOP1,ATTRNAME,"TH36 C96 8.5""PVC W" 

6128,1572076.402,2075424.612,1008.0,SUETOP2 ST,ATTRNAME,"TH41 C110 8.5""PVC W" 

6126,1571817.716,2075529.155,1008.5,SUETOP2,ATTRNAME,"TH42 C111 8.5""PVC W" 

6216,1571697.883,2075595.682,1020.4,SUETOP2,ATTRNAME,"TH43 C112 8.5""PVC W" 

6618,1571598.974,2075614.690,1020.6,SUETOP2,ATTRNAME,"TH44 C113 8.5""PVC W" 

6238,1572017.436,2075527.254,1019.0,SUETOP3 ST,ATTRNAME,"TH124 C299 13""DIP W" 

6234,1571720.708,2075654.606,1019.2,SUETOP3,ATTRNAME,"TH125 C301 13""DIP W" 

6289,1571564.736,2075728.737,1019.4,SUETOP3,ATTRNAME,"TH126 C303 13""DIP W" 

6291,1571137.119,2076073.372,1019.6,SUETOP3,ATTRNAME,"TH127 C304 2.5""DBC T 13""DIP W" 

62910,1570443.921,2076674.042,992.0,SUEBOT3,ATTRNAME,"TH127 C304 2.5""DBC T 13""DIP W" 

 

6. Create an InRoads survey field book (.FWD).  This file is used to import and process the raw 

field survey data in the CSV file.  This file is not normally seen or used by the Designer but is 

required to import and process the PI#_SUE_ Chains.csv file. 

a. In the InRoads workspace bar, make the Survey tab the active tab.  

b. In InRoads, select File  New 

c. Click on the Survey Data tab to make it the active tab. 

d. In the Name: field key-in PI#_SUE. 

e. Click Apply & Close. 

f. You should now see the new Survey Data file listed in the InRoads workspace bar. 

g. Even though the Survey Data file is listed in the InRoads workspace bar, the file has not 

yet been saved.  Save the file by selecting File  Save  Survey Data and naming the 

file PI#_SUE.fwd. 

7. Import the PI#_SUE_Chains.csv file. 

a. In InRoads, select File  Import  Survey Data 

b. In the Import dialog, set the Files of type: to GDOT Trimble Format (*.csv). 

c. Navigate to and select the PI#_SUE_Chains.csv file. 

d. Click Import and Close.  

8. When importing field survey, the InRoads field book automatically displays the planimetrics. 

Turn off the display of the planimetrics by clicking SurveyView Survey Data and 

unchecking Planimetrics as shown below. 
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9. While much can be done with the InRoads field book, its only purpose by Design for 

subsurface utilities is as a repository to import the survey data and export it to an InRoads 

DTM.  To do this, a new DTM surface named PI#_SUE.dtm must be created. 

a. In the InRoads workspace bar, make the Surfaces tab the active tab 

b. In InRoads, select File  New 

c. Ensure the Surface tab is the active tab. 

d. In the Name: field key-in PI#_SUE. 

e. If desired, enter a description. 

f. Click Apply & Close. 

g. You should now see the new Surface file listed in the InRoads workspace bar. 

h. Even though the Surface file is listed in the InRoads workspace bar, the file has not yet 

been saved.  Save the file by selecting File  Save  Surface and naming the file 

PI#_SUE.dtm 

10. Export the survey data from the PI#_SUE.fwd InRoads field book to the PI#_SUE.dtm surface. 

a. Ensure the PI#_SUE.dtm surface is the active surface.  There should be a red square 

next to the surface name in the InRoads workspace bar. 

b. In InRoads, select Survey Survey Data to Surface. 

c. Verify that the surface name reads PI#_SUE. 

d. Click the Preferences button and load the preference named GDOT. 

e. Click the Filter button and select the filter named DTM Surface Codes. 

f. Click OK to close the Survey Style Filter dialog. 

g. Click OK in the Survey Data To Surface dialog. 

h. In the Triangulate Surface dialog click Apply & Close.  Although no SUE data will be 

triangulated, this step must be performed to prevent error messages from appearing when 

you go to display the surface features on the cross sections. 

i. Save the changes by selecting File  Save  Surface. 
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11. Review the subsurface utilities in the PI#_SUE.dtm. 

a. In InRoads, select Surface  Feature  Feature Properties. 

b. In the Feature Properties dialog, review the Feature Names, Styles and Descriptions.  

The SUE Consultant has entered Descriptions for the Test Hole number, conflict number 

(if available), and utility so that the designer can associate the feature name with 

information in the Utility Impact Analysis (UIA) spreadsheet provided by the State Utilities 

Office. (Please note that a UIA is not provided on all projects; therefore, a conflict number 

may not be part of the description provided in the CSV file by the SUE Consultant.)   

c. Click Close to exit the Feature Properties dialog. 

12. Before creating cross sections, those Features that were identified previously as chains must 

have their Feature Type changed from Random to Breakline in the DTM.  Unfortunately in 

InRoads - when Features are moved from the FWD file to the DTM file - the features are 

renamed.  So identifying those Features in the DTM that are chained is required.  One method 

to do this is to match up the description in the CSV file with the description in the DTM.  The 

description in the CSV file next to the ST start command is the description that you will find in 

the DTM and those are your chains. 

a. Open your CSV file in a text editor and find the descriptions on the same line as the ST 

start command. 

Point                                                                         Feature        InRoads              

No.     | Northing         | Easting             | Elev.    | Code          | Functionality  | Description                              

6118,1571994.611,2075443.620,1009.0,SUETOP1,ATTRNAME,"TH36 C96 8.5""PVC W" 

6128,1572076.402,2075424.612,1008.0,SUETOP2 ST,ATTRNAME,"TH41 C110 8.5""PVC W" 

6126,1571817.716,2075529.155,1008.5,SUETOP2,ATTRNAME,"TH42 C111 8.5""PVC W" 

6216,1571697.883,2075595.682,1020.4,SUETOP2,ATTRNAME,"TH43 C112 8.5""PVC W" 

6618,1571598.974,2075614.690,1020.6,SUETOP2,ATTRNAME,"TH44 C113 8.5""PVC W" 

6238,1572017.436,2075527.254,1019.0,SUETOP3 ST,ATTRNAME,"TH124 C299 13""DIP W" 

6234,1571720.708,2075654.606,1019.2,SUETOP3,ATTRNAME,"TH125 C301 13""DIP W" 

6289,1571564.736,2075728.737,1019.4,SUETOP3,ATTRNAME,"TH126 C303 13""DIP W" 

6291,1571137.119,2076073.372,1019.6,SUETOP3,ATTRNAME,"TH127 C304 2.5""DBC T 13""DIP W" 

62910,1570443.921,2076674.042,992.0,SUEBOT3,ATTRNAME,"TH127 C304 2.5""DBC T 13""DIP W" 

 

b. In InRoads, select Surface Feature Feature Properties.  In the Description column 

(which you may need to expand to see), identify those Descriptions found in Step 12 a. 

These are your chains.  In this example, the Features with the Descriptions ,"TH41 C110 

8.5""PVC W" and ,"TH124 C299 13""DIP W" are the Features whose Feature Types need 

to be changed to Breakline. 
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c. To change the Feature Type, select (highlight) one of the Features which needs to be 

changed.  In the Triangulation field, use the pull down menu to change the Feature Type: 

to Breakline as shown below.  Click Apply to save the change and repeat the step for 

each of your chains. 

 

d. Click Close to exit the Feature Properties dialog. 
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13. Cross sections can now be created and the SUE utilities should automatically be displayed.  

a. Set the Global Scale Factors to 10.0. 

b. Select Evaluation  Cross Section  Cross Sections 

c. Load the appropriate preference (‘Narrow 10h 10v’ or ‘Wide 10h 10v’). 

d. In the Cross Sections dialog, under the General leaf, ensure the Existing Ground 

Surface, Finished Surface and the new SUE Surface DTM’s are checked as shown below. 

 

e. Click Apply but do not close the Cross Sections dialog. 

f. If the following message box appears, click Yes. (The reason this message may appear 

is because the Features were changed in the previous steps from a Feature Type of 

“Random” to “Breakline”). 
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g. Next, Left click in the MicroStation screen to place the cross sections. 
h. The SUE utilities should be displayed on the cross sections similar to that shown below. 

**NOTE: The top of the SUE utility is represented by a green inverted triangle with the 

origin at the bottom point.  If collected, the bottom of the utility is represented by a red 

triangle with the origin at the top point. 

 

14. If desired, the SUE utility can be annotated. 

a. If not still open from the previous step, select Evaluation  Cross Section  Cross 

Sections to open the Cross Sections dialog. 

b. Click the Annotate Cross Section folder and select the General leaf. 

c. Load the preference named (‘XSEC TEXT - SUE’) 
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d. Place a Check in the Check Box next to the Surface PI#_SUE and click Apply. 

e. Each of the SUE utilities should be annotated as shown below.  

PLEASE NOTE: At the time of this writing a bug in the InRoads software may prevent the 

PI#_SUE surface from appearing under the Annotate Cross Section Surfaces list. If this 

surface is missing from the list in the Cross Sections dialog, close the Cross Sections 

dialog and reopen it and the surface will appear in the list. Then repeat Steps b – d to 

annotate the cross sections. 

**NOTE: All annotation will be displayed on the level XSEC_E_SUETOP-Text regardless of 

whether or not the utility represents the top or bottom of the utility. 

 

f. Close the Cross Sections dialog. 

16. This completes this workflow process for Method #2. 
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 Process to Generate Borrow Pit Quantity  

Objective: The following process is utilized to generate the Borrow Pit Quantity from a “Delta” 

Triangle Volume comprised of the Earthwork quantity calculated between an Existing and Finished 

Borrow Pit surface area. 

Requirements: You must have an InRoads DTM of the Existing Borrow Pit Surface and the 

associated DTM of the Finished Borrow Pit Surface.  These Surfaces should be provided to the 

Designer from the District Location Office/SDE.  These two Surfaces are used to create the “Delta” 

Triangle Volume Borrow Pit Quantity. 

Procedure: 

A. Open the Existing Borrow Pit Surface (.DTM) in InRoads 

1. In InRoads, select FileOpen 

2. Select the .DTM File (Surface) that contains the Existing Borrow Pit Surface. 

B. Open the Finished Borrow Pit Surface (.DTM) in InRoads 

1. In InRoads, select File Open 

2. Select the .DTM File (Surface) that contains the Finished Borrow Pit Surface. 

C. Generate the Borrow Pit Volume 

1. In InRoads, select Evaluation VolumesTriangle Volume and the Triangle Volume 

dialog opens. 

2. Following is a screen capture of example entries. Ensure your entries correspond to the 

following dialog (substitute your Surfaces where applicable).  

 

3. In the Triangle Volume dialog, click the Add button. 

4. The Triangle Volume dialog should appear similar to below: 
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5. In the Triangle Volume dialog, click the Apply button and the Triangle Volume Report 

should open up in the TriangleVolumes.xsl style sheet. (If the Style Sheet opens up in a 

different format – browse to the TriangleVolumes.xsl style sheet under the Bentley Civil 

Report Browser >>Evaluation leaf.) 

The Delta quantity will be the Cut volume in cu yds. See screen capture below: 

  



InRoads Workflow Processes SS2   
 

 

Rev 2.0                                                                                                  8. Process to Generate Borrow Pit Quantity 

8/2/17                                                                                                                                                                     Page 8-3 

 

  



InRoads Workflow Processes SS2   
 

 

Rev 2.0                                                                                                  8. Process to Generate Borrow Pit Quantity 

8/2/17                                                                                                                                                                     Page 8-4 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Intentionally Left Blank 



InRoads Workflow Processes SS2   
 

 

Rev 2.0                                                                            9. Using Drafting Notes to Annotate Plans/Profiles - Contents 

8/2/17                                                                                                                                                                       Page 9-i 

 Using Drafting Notes to Annotate Plans/Profiles - 
Contents 

 Using Drafting Notes to Annotate Plans/Profiles - Contents .......................................... 9-i 



InRoads Workflow Processes SS2   
 

 

Rev 2.0  9. Using Drafting Notes to Annotate Plans/Profiles 

8/2/17                                                                                                                                                                     Page 9-1 

 Using Drafting Notes to Annotate Plans/Profiles  

Objective: The following process is utilized to easily annotate critical points on Plan and Profile 

Sheets.  A list of Drafting Notes and brief explanations are provided below. 

Requirements: You must have the latest GDOT InRoadsALL downloaded and installed and must be 

working in the latest GDOT WorkSpace. 

Procedure: 

A. Update GDOT Microstation Workspace and InRoadsALL 

1. Ensure both Microstation and InRoads have been updated with the latest GDOT 

configuration files located on the ROADS page. 

B. Set up Project Defaults in InRoads 

1. The GDOT Drafting Note.dft file that stores all of the Drafting Notes is automatically 

unzipped to the C:\InRoads Data\Standards\ folder when InRoadsALL is installed.  Users 

can either copy this file into ProjectWise or else leave the file in the default folder above.  

NOTE: future InRoadsALL updates will only update the file in the default location at 

C:\InRoads Data\Standards\. 

2. In InRoads, select File Project Defaults and enter the full path of the desired location 

of the Drafting Notes file.  If the default location is desired, enter: C:\InRoads 

Data\Standards\; otherwise, enter the full ProjectWise path where the Drafting Notes file 

was copied.  Click Apply and Close.  See screen capture below: 
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C. Annotating Plan Sheets 

1. Set Active Angle to 0° in Microstation. 

2. Reference all individual Plan Sheets.  Rotate view such that the Plan Sheet you wish to 

annotate is oriented at 0°.  This ensures all Drafting Notes are oriented correctly. 

3. In InRoads, select Drafting Place Plan Note.  EXCEPTION: If you are annotating an 

Alignment Intersection on a Plan Sheet, you will instead choose Drafting Place 

Alignment Intersection Note. 

4. If you properly set up the Project Defaults in Section B, then the GDOT Drafting Notes.dft 

file should already be loaded.  If not, then you can manually open it up using File Open.  

All GDOT Drafting Notes are located under the Proposed sections.  See screen shots 

below (click the ▲button near the bottom to view the bottom section), which show both a 

Plan Note as well as an Alignment Intersection Note: 
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5. Highlight the desired Note to be placed. 

6. For Plan Notes that annotate a Station, a Horizontal Alignment must be selected in the 

window above.  For Alignment Intersection Notes (currently, GDOT provides only 1 

such Note), ensure that the Intersection radio button is selected, as shown above.  Click 

Apply. 

7. See below depending on which Note you are placing: 

a. Alignment Intersection Note: As prompted, select the Alignment that you wish to 

annotate first, Accept, and then select secondary Alignment and Accept.  Next, select 

the quadrant where you want the Note to appear (this doesn’t appear to matter, as you 

can move it anywhere), and then drag the Note wherever you desire and click to place. 

b. Plan Note:  For most Notes, you will only need to click on the anchor point where you 

want the Station flagged and then drag the Note to the desired location and click again 

to Accept.  For some of the R/W and Easement Points though, you will first need to 

use the Origin or Center Snap in Microstation prior to clicking on the desired anchor 

point in order to have the leader line of the Drafting Note start at the center of the point. 
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D. Annotating Profile Sheets 

1. In InRoads, select Drafting Place Profile Note. 

2. If you properly set up the Project Defaults in Section B, then the GDOT Drafting Notes.dft 

file should already be loaded.  If not, then you can manually open it up using File Open.  

All GDOT Drafting Notes are located under the Proposed sections.  See screen shot below 

(click the ▲button near the bottom to view the bottom section): 

 

3. Highlight the desired Note to be placed and click Apply. 

4. On the desired Profile/Vertical Alignment, click on the anchor point that you wish to 

Annotate and then drag the Note to the desired location.  Click again to Accept. 

5. NOTE: For the Side Road Description & STA Drafting Note, the user will need to 

manually edit the desired text for the Side Road Description, since there is no secondary 

alignment to click on to automatically fill-in the description. 

6. NOTE: Drafting Notes for Wall Envelopes are also covered in the next InRoads Workflow 

Process 10: Developing Wall Envelopes in InRoads. 
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See below for a listing and brief explanation of all available Drafting Notes: 

Drafting Note Note Type Description 

Alignment Intersection 

Alignment 

Intersection/ Plan 

(Proposed) 

Labels Descriptions and Stations of 2 

intersecting alignments. 

Approach Slab - BEGIN Plan (Proposed) Beginning Station of Approach Slab 

Approach Slab - END Plan (Proposed) Ending Station of Approach Slab 

Bridge 1-3 - BEGIN 
Plan/Profile 

(Proposed) 

Beginning Station of Bridge (3 separate Bridge 

Notes are provided) 

Bridge 1-3 - END 
Plan/Profile 

(Proposed) 

Ending Station of Bridge (3 separate Bridge 

Notes are provided) 

Easement - Point Name Plan (Proposed) 

Labels Point Name. Separate options available 

for Driveway, Permanent and Temporary 

Easements. 

Easement - STA-Offset Plan (Proposed) 

Labels Station-Offset. Separate options 

available for Driveway, Permanent and 

Temporary Easements. 

Guardrail-Begin Plan (Proposed) 

Beginning Station of Guardrail/Terminal. 

Separate options for T-BEAM, W-BEAM, W-

BEAM/TYPE 1 Terminal, and W-

BEAM/TYPE 12A-C Terminal. 

Guardrail-End Plan (Proposed) 

Ending Station of Guardrail/Terminal. Separate 

options for T-BEAM, W-BEAM, W-

BEAM/TYPE 1 Terminal, and W-

BEAM/TYPE 12A-C Terminal. 

Northing/Easting Point Plan (Proposed) Labels a Point with Northing/Easting. 

Orange Fence Barrier - BEGIN Plan (Proposed) Beginning Station of Orange Fence Barrier 

Orange Fence Barrier - END Plan (Proposed) Ending Station of Orange Fence Barrier 

Project - BEGIN 
Plan/Profile 

(Proposed) 
Beginning Station of Project 

Project - END 
Plan/Profile 

(Proposed) 
Ending Station of Project 

REQD R/W – Point Name Plan (Proposed) 
Labels Point Name of Required Right of Way 

point (non-Marker). 

REQD R/W Marker– Point Name Plan (Proposed) 
Labels Point Name of Required Right of Way 

Marker 

REQD R/W – STA-Offset Plan (Proposed) 
Labels Station-Offset of Required Right of Way 

points. 

Side Road Description & STA 
Profile 

(Proposed) 

Labels Station of Side Road. User must enter 

Side Road Description manually. 

Wall BEGIN-STA (Plan) & Wall 

BEGIN-STA-Elev (Profile) 

Plan/Profile 

(Proposed) 

Labels STA (Plan) or Station-Offset (Profile). 

Separate options available for Parapet, Type 2 & 

Type 6 Walls. 

Wall END-STA (Plan) &  

Wall END-STA-Elev (Profile) 

Plan/Profile 

(Proposed) 

Labels STA (Plan) or Station-Offset (Profile). 

Separate options available for Parapet, Type 2 & 

Type 6 Walls. 

 

  



InRoads Workflow Processes SS2   
 

 

Rev 2.0  9. Using Drafting Notes to Annotate Plans/Profiles 

8/2/17                                                                                                                                                                     Page 9-6 

 

 

 

 

 

 

 

 

 

 

 

 

 

Intentionally Left Blank 

 

 

 

 

 

 

 

 



InRoads Workflow Processes SS2   
 

 

Rev 2.0                                                                                          10. Developing Wall Envelopes in InRoads - Contents 

8/2/17                                                                                                                                                                      Page 10-i 

 Developing Wall Envelopes in InRoads - Contents 

 Developing Wall Envelopes in InRoads - Contents ................................................... 10-i 



InRoads Workflow Processes SS2   
 

 

Rev 2.0  10. Developing Wall Envelopes in InRoads 

8/2/17                                                                                                                                                                     Page 10-1 

 Developing Wall Envelopes in InRoads   

Objective: To use InRoads and Microstation to develop Wall Envelopes. 

Requirements: This guide is intended for intermediate to advanced InRoads users.  Less proficient 

InRoads users should first go through the training modules available on the ROADS web page. 

A sample dataset is used to provide graphics and to show what final deliverables will look like.  The 

following is a list of current templates found in the Standard GDOT ITL in InRoadsALL that may be 

used to develop Wall Envelopes: 

 Gravity Wall for 2:1 Backfill 

 Gravity Wall for 4:1 Backfill 

 Gravity Wall for flat Backfill with no traffic 

 Gravity Wall for flat Backfill with traffic 

 Gravity Wall with Barrier Face for 4:1 Backfill 

 Gravity Wall with Barrier Face for flat Backfill 

 Gravity Wall with Barrier Face for 2:1 Backfill 

 TP P1, P2 & P3 Parapet Retaining Wall for 2:1 Back Slopes 

 TP P1, P2 & P3 Parapet Retaining Wall for 3:1 Back Slopes 

 TP P1, P2 & P3 Parapet Retaining Wall for 4:1 Back Slopes 

 TP P1, P2 & P3 Parapet Retaining Wall for 6:1 Back Slopes 

 Type 2S 

 Type 6S 
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All of the above listed templates use Feature Styles at specific points on the barriers to denote the critical points that are used to generate the Wall Envelopes.  Below are graphics of each major type of the above templates, 

showing where these critical points are, as well as what the default Feature Styles are of these points.  Please refer to the Template Documentation for tips on how to use and edit these Templates. 
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Procedure: 

A. Creating Wall Corridor/s - A special Corridor/s should be set up just for the purpose of 

delineating the most accurate beginning/ending Stations of where the different Wall 

components transition from one size/type to another (for example, going from a Type 2-S 

barrier to a Type 2-SA barrier), in order to develop the Wall Envelopes.  These special 

Corridors should only include the area of a project where the Walls are located. 

The reason why you do not want to use the entire Corridor of your project is because the 

Roadway Designer in InRoads tends to crash at really small intervals for Station Drops when 

you click the “Process All” button.  It’s possible that you may need to use more than one 

Corridor, depending on factors such as your Operating System, computer 

specifications/hardware/graphics card, version of InRoads, etc. 

A sample project dataset is used to illustrate the steps and final deliverables.  The original 

Design profile was edited to create a need for Walls.  Although only one template (Type 2S) 

is being detailed in this documentation, the workflow for the other templates is the same.  The 

only exception is for Gravity Walls, where less annotation is needed since these walls are of 

a singular type and do not switch to different sizes like the other wall types do. 

1. Determine the general area/length of where the Wall is required.  Do this by dropping the 

Template that includes your Wall along the entire main Corridor, using an interval of 5’.  

Navigating through the Roadway Designer should give you a good idea of where the Walls 

will be needed. 

2. Create a new Corridor for the entire area where a Wall is needed.  Make sure to specify 

the approximate beginning/ending Stations of the Corridor.  In the example project, the 

original Corridor runs from Station 101+50 to 185+50.   After dropping a Template (that 

includes Type 2S components on both sides of the centerline), it is determined that both 

sides start around 119+80.  The left side will continue until 133+50 and the right side until 

135+00 (the left side can be ignored after 133+50 since you can specify later on what 

Station limits you wish to view on your Profile sheet).  Save the IRD file now.  See graphic 

below, that shows the Corridor: 
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B. Drop Templates - Drop your Templates (that includes the Wall components) along the entire 

Wall Corridor created previously.  Ensure that you use an interval of 0.1’.  After closing the 

Template Drops dialog box (and saving the IRD again), click the “Process All” button.  If 

InRoads does not crash, proceed to Step 3 below; otherwise, you will need to break up your 

Corridor into multiple, smaller Corridors and perform each of these steps separately for each 

Corridor. 
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C. Create Surface/s - You will need to create a separate Surface for each Wall Corridor created.  

Only do this for the Corridors that used a Template Drop interval of 0.1’ (not your initial 5’ 

interval to determine the general area of the Walls), and only after clicking the Process All 

button.  Be sure to select the “FINISH” Preference and also manually check the “Include Null 

Points” box before clicking Apply.  There are no Null Points in the Gravity Wall Templates, so 

there’s no need to check this box when using Gravity Walls.  See graphic below. 

Important: Save each Surface after you have created it, before moving on to create the next 

Surface.  InROADS will sometimes crash during this process, similar to when clicking Process 

All in the Roadway Designer.  In the event of a crash, once again, you will need to break up 

your Corridor into multiple, smaller Corridors and start over. 
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D. Plotting Wall Envelopes 

1. Create a new DGN file to draw your Wall Envelopes and use the Plan and Profile 

Generator in InROADS to plot them.  You can reference the instructions in Lab 6 of the 

InRoads Design Training Guide (found on the ROADS webpage), if needed.  Although 

both the Existing Ground and Design Profiles will initially be plotted in the drawing, you 

can simply turn off these levels so that only the Wall Envelopes will be displayed.  Make 

sure to Save Settings so that it remembers to keep these levels turned off. 

2. Tip: Sometimes the profile does not appear in the middle of the profile sheet, which is 

usually the desired location.  If this happens, you may adjust the settings to correct this.  

To do this, open the dialog box under Evaluation>Profile>Create Profile.  Load an existing 

GDOT Preference to get default values.  Then, under the Control tab, adjust the Window 

Clearance as needed.  If the profile is showing up near the bottom of the profile window, 

then increase the Bottom value; if it’s showing up near the top of the profile window, then 

increase the Top value.  Once you adjust this value satisfactorily, you should Save this as 

a new Preference (make sure to choose “Save As” and not “Save”, or you might overwrite 

the GDOT Preference) and choose this as the Profile Preference in the Plan and Profile 

Generator (Profile Controls tab) in InROADS.  Additionally, you may want to change the 

spacing of the Stations to be every 50’ instead of 100’.  Finally, if you do have Super 

Elevation Control Lines showing up in the Plan and Profile Generator, ensure that you 

click the ‘None’ button; otherwise, they will produce undesired results in the main Profile 

dgn file.  See screen captures below:   
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3. Plot Wall Profiles by using the command Evaluation>Profile>Update Profile.  Ensure that 

all Surfaces created for the Walls are open in InRoads.  You will need to Display ALL of 

the Projected Features that use the Feature Styles shown on the appropriate Template 

diagrams on page 3.  There are only 2 Feature Styles we are concerned with, but they 

vary according to which Wall Type you are using.  You will need to do this step for each 

Surface, either separately or all at once.  Simply select the “Display On” Radio Button at 

the top, highlight the desired Surface/s, and then sort the Projected Features by Style by 

clicking on the Style header (if they don’t show up at the top, click the Style header again 

to reverse the order).  All of the Feature Styles will be grouped together.  Note:  If you 

have Walls on both sides of the roadway, you should treat them completely separate; you 

will only plot the Wall Envelope of one side of the roadway on the Profile and then create 

a new Profile for the other side later.  This is another reason why it is helpful to add prefixes 

to the Point Names, especially in these dual-side situations (instructions for doing this are 

in the individual Template descriptions), designating whether it is on the left or right side 

of the roadway.  See screen capture below: 
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4. Navigate to the dgn sheet file.  After turning off the reference levels PROF_E_Ground-

Line, PROF_P_CONSTCL-Cell and PROF_P_CONSTCL-Line (the proposed and 

existing ground profiles of the centerline), the Wall Envelopes should be all that is 

displayed in the sheet dgn file.  Make sure to Save Settings so that it remembers to keep 

these levels turned off.  See sample sheet file below: 
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E. Annotating Wall Envelope Elevations at Major Stations 

1. Navigate back to the original dgn file where the Wall Profiles are stored (not where the 

sheet cell is located). 

2. Open the command Evaluation>Profile>Annotate Feature in Profile… 

3. Load the Preference called WallProfiles.  This Preference will automatically label the 

elevations for both Feature Styles (i.e. the Top and Bottom Wall Envelopes) every 50’. 

4. Open the Annotate tab and select the appropriate Surface that you wish to annotate.  You 

will now see all of the Point Names and Feature Styles available to annotate.  Right click, 

choose Select All and click Apply.  See screen capture below: 

 

5. Now all elevations are labeled every 50’ along the axis.  The lower elevation should be on 

the left of each Station tick and the higher elevation to the right of each Station tick.  If you 

only want them annotated at 100’ intervals, then simply change the value in the General 

tab. You may wish to save this as another Preference.  See screen capture shown below: 



InRoads Workflow Processes SS2   
 

 

Rev 2.0  10. Developing Wall Envelopes in InRoads 

8/2/17                                                                                                                                                                   Page 10-16 

 

6. Your Wall Envelope should now look similar to the example sheet on the following page:  



InRoads Workflow Processes SS2   

 

 

Rev 2.0                                                                                                                                                                                                                                                                10. Developing Wall Envelopes in InRoads 

8/2/17                                                                                                                                                                                                                                                                                                                                                                                                                 Page 10-17 

 



InRoads Workflow Processes SS2   

 

 

Rev 2.0                                                                                                                                                                                                                                                                10. Developing Wall Envelopes in InRoads 

8/2/17                                                                                                                                                                                                                                                                                                                                                                                                                 Page 10-18 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Intentionally Left Blank



InRoads Workflow Processes SS2   
 

 

Rev 2.0  10. Developing Wall Envelopes in InRoads 

8/2/17                                                                                                                                                                   Page 10-19 

F. Annotating Wall Envelope Transitions - In this step, you will annotate all of the Stations 

where the transitions occur when the Walls switch from one size/type to another.  In addition, 

you will also annotate the beginning/ending Stations.  For Gravity Walls, there are no such 

transitions to be concerned with: you only need to annotate the beginning/ending Stations. 

If you look at the two profiles in Microstation, you will notice that one is continuous (for 

Type 2 Walls, it’s the BFGL Points in red at the top) and the other is broken up into 

shorter runs (for Type 2 Walls, these are the various SBX Points in green).  You will 

need to manually draw some lines temporarily to create points to annotate along the 

continuous profile. 

1. Go to File>Project Options… and then go to the Precision tab.  Change the Elevation 

precision to be only two decimal places (select 0.12).  Click Apply and Close. 

2. Drag your cursor along the discontinuous profile (in this case, the green one) until you 

reach the 2nd segment.  You will need to draw a 90° line (or 270° for a Type 6 Wall) from 

the beginning of the 2nd segment up to the red, continuous profile above it (and trim/extend 

to intersection, as needed), as shown here (see special note below first): 
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NOTE:  If you zoom close into the transition area, you will notice a gap between where 

the Wall types switch (in this case, from Type 2-S to Type 2-SA).  This gap is exactly 0.1’ 

horizontally, which is the interval that you used to drop your Templates in the Roadway 

Designer.  Ensure that you draw this 90° line at the beginning of the 2nd segment and not 

the end of the first segment.  You want to annotate the Station where the new Type begins.  

See screen capture below: 

 

3. Continue drawing these 90° lines at the beginning of each transition (and intersecting them 

with the other profile) until you reach the last segment.  Remember to zoom in close before 

trying to Snap to the desired location, because these are actually line strings that have 

nodes about every 0.1’.  Therefore, it’s difficult to know if you have Snapped to the correct 

point if you are zoomed out too far. 

Similarly, before you trim/extend these 90° lines, you must zoom very far into the 

intersection point before selecting the element to trim/extend to.  Clicking while zoomed 

out will most likely give you an incorrect point, since these line strings are so small. 

Now you have all of the points that you need to annotate the exact Stations and Elevations 

of the transitions. 

NOTE:  For some Type 2 and Parapet Retaining Walls only, the “green” profile (i.e. the 

Existing Ground Line where the back slope hits the front of the Wall) will sometimes 

“step” from one size/type to another.  This is due to how the GA Standard/Construction 

Detail dictates where these points are located.  Whether it “steps” or not is based upon 

different factors for each wall type: 

 For Type 2 Walls, the step will appear on transitions from Type 2-SA and Type 2-

SB, from Type 2-SB to Type 2-SC, and the reverse transitions. 

 For Parapet Retaining Walls, the step should only appear when using the 

template provided for the 4:1 and 6:1 Back Slopes. 
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Type 6 and Gravity Walls don’t have this “stepping” issue, although the gaps due to the 

Station Drop Intervals exist in all of the Wall Envelopes.  See screen capture below for an 

example of this “step” in the profile. 

 

4. The Designer may wish to connect these gaps and/or steps for Plan Presentation 

purposes, although they are quite small.  Simply draw them using the same level as the 

appropriate profile you are connecting. 

5. Now you can finally annotate all of these points, using the Drafting>Place Profile Note 

InRoads command.  Prior to doing this, ensure that you have downloaded and installed 

the latest InRoadsALL.  See InRoads Workflow Process 9 to ensure you have set up your 

Project Defaults for the GDOT Drafting Notes.dft file.  In this dialog box, highlight the 

desired Wall Note under the Proposed folder, as shown below: 



InRoads Workflow Processes SS2   
 

 

Rev 2.0  10. Developing Wall Envelopes in InRoads 

8/2/17                                                                                                                                                                   Page 10-22 

 

6. Click Apply.  Now, simply zoom really close in to the point that you need to annotate along 

(in this case) the green profile, snap to the point, left-click, and then zoom out some so 

you can see where to place the annotation.  TIP:  Since all of your points except the 

beginning and ending stations have the temporary 90° lines drawn, you can easily use 

these to snap to without having to zoom so far in. 

7. Continue annotating in this fashion until all Transition Points have been annotated. 

8. Edit the text if needed.  Adjust Leader Lines as desired.  Once complete, delete the 

temporary 90° lines, as they are no longer needed. 

9. NOTE: All leader lines and text are now on the same level (PROF_P_Retain-Wal-Text), 

although the following screen capture shows them on separate levels. This makes it easier 

to turn them all off/on at once.  See screen capture below: 
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G. Add Cell of Retaining Wall Typical Section - There are cells in the Typical-Sections cell 

library in Microstation that can be dropped onto the Wall Envelopes profile sheet to reference.  

The names of these Cells are as follows: 

Cell Name Cell Description 
WALLP Parapet Retaining Wall 

WALLGBF Gravity Wall with Barrier Face 

WALLG Gravity Wall 

WALL6 Type 6 Concrete Side Barrier 

WALL2 Type 2 Concrete Side Barrier 

 

Included below are sample Wall Envelope Profile Sheets showing what the final Wall 

Envelope should look like for each of the 5 major Wall Types, and the Cells above are included 

as well.  The first one shown is for the example used in this Training Guide.  Notice that the 

colors of the Profiles, Elevations and Critical Points on the Cells all correspond for clarity. 

NOTE: All leader lines and text for Drafting Notes are now on the same level 

(PROF_P_Retain-Wal-Text), although the following screen captures show them on separate 

levels.  This makes it easier to turn them all on/off at once. 
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 Merging DEM Surfaces and Viewing Contours in 
InRoads  

Objective: The following process is utilized to merge multiple “quad maps” (DEMs) into InRoads 

surfaces (DTMs).  Users can also view these as Contours from within InRoads. 

Requirements: You must an internal user to access some of the files.  External users will need to 

obtain their own DEMs and import them into InRoads as a DTM, but can still use this process as a 

guide. 

Procedure: 

Statewide “Quad Maps” are now available as Digital Elevation Models (DEMs) at 10 meter resolution, 

located here.  These have conveniently been converted to InRoads Digital Terrain Models (DTMs), 

located here.  InRoads users can easily open the DTMs for their use (viewing contours, cutting cross 

sections, etc.), without first having to import the DEMs.  In short, for internal InRoads users, the DEMs 

are not needed. 

Since a project’s watershed often falls in more than one “quad map”, the designer may need to open 

two or more “quad maps”, merge them together into one surface, and then clip out what is not needed.  

The reason you need to clip out the unnecessary portion is to make it quicker to view and label the 

contours.  Follow these steps to do this: 

A. Determine Which Quad Maps You Need 

1. In your Microstation DGN file, view your horizontal alignment. 

2. Reference in the East (and/or West, as needed) Quad Index V8i Version.DGN file/s, 

located here.  Now you can determine which quad maps you need. 

B. Obtain DTM files 

1. Go here for the DTM files of the Quad Maps. 

2. Make a copy of the DTM files of the Quad Maps that you will need and paste them on your 

desktop or somewhere on your hard drive/network other than the Imagery folder where 

these original files are kept. 

C. Create Final Merged and Clipped DEMs 

1. In InRoads, open the DTM Surface/s that you copied in step 2.  Skip to Section E if you 

only have one Quad Map. 

2. Create new Surfaces for merging.  Add up the total number of quad maps you need to 

merge, add 1, and this is the total number of Merged Surfaces you will need to create.  

For the Names of the Surfaces, be sure to include the DEMs that you wish to merge (i.e. 

PortWentworth_GardenCity_DEM). The final merged Surface is called 

Final_Merged_DEM, and the final clipped Surface is called Final_Clipped_DEM, to 

distinguish them from the others.  Below is an example, given a list of 4 adjacent Quad 

Maps: 

a. The four Quad Maps to merge are: 

 255_E_Meldrim 

file://///gdot.ad.local/RoadDesign/Imagery/Quad-Maps/Original%2010-Meter%20Resolution%20DEM%20Files/
file://///gdot.ad.local/RoadDesign/Imagery/Quad-Maps/DTM%20Conversions%20of%20DEM%20Files/
file://///gdot.ad.local/RoadDesign/Imagery/Quad-Maps/
file://///gdot.ad.local/RoadDesign/Imagery/Quad-Maps/DTM%20Conversions%20of%20DEM%20Files/
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 256_E_Port Wentworth 

 274_E_Meldrim SE 

 275_E_Garden City 

b. The five names we will use for the Surfaces are: 

 Meldrim_PortWentworth_DEM 

 Meldrim_PortWentworth_MeldrimSE_DEM 

 Meldrim_PortWentworth_MeldrimSE_GardenCity_DEM 

 Final_Merged_DEM (all 4 DEMs merged together) 

 Final_Clipped_DEM 

To Create a New InRoads Surface, select File > New. 

a. Set the Type to Existing. 

b. Enter the Name. 

c. Set Maximum Length to 300.00. 

d. Set the Preference to EXISTING. 

e. Click Apply.  Repeat until all DEM Surfaces have been created and then click Close. 

NOTE: If you only need a single Quad Map, then you may only need to create the 

Final_Clipped_DEM (the Quad Map may not need to be clipped at all though, depending 

on your project location).  You can only merge two Surfaces at a time. 

D. Merging Multiple Quad Maps Together 

1. If you need multiple Quad Maps to provide enough coverage, you will need to merge them 

into a single Surface, so that you can create a single, clipped Surface.  To do this: 

a. Select Surface > Edit Surface > Merge Surfaces… 

b. Using the example of 4 Quad Maps above, match the selections shown in the following 

screen capture: 
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Since both Surfaces have the same accuracy and source (10-meter resolution DEMs), 

it doesn’t matter which you choose to be the Design or Original Surface.  However, for 

the Destination Surface, be sure to choose the appropriate Merged Surface that you 

created in Step 4.  Sometimes these DEM Surfaces overlap, so also be sure to check 

the “Retain All Original Surface Points” box, as shown. 

c. Click Apply.  Keep Merge Surfaces dialog box open. 

d. Next, change the Original Surface in the pull-down to be the new Merged Surface that 

you just created (in this case, Meldrim_PortWentworth_DEM).  The new Design 

Surface will be the next adjacent quad map (in this case, 274_E_Meldrim SE).  Finally, 

the Destination Surface should be the appropriately-named Merged Surface (in this 

case, Meldrim_PortWentworth_Meldrim SE_DEM).  Click Apply. 

e. Continue in this fashion until all 4 Surfaces have been merged (the 

Final_Merged_DEM Surface).  The last Surface named in Step 3, 

Final_Trimmed_DEM, will now be created.  Click Close. 
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E. Viewing Contours of DTM 

1. Ensure the Style Lock is turned off for the next step.  In InRoads, Select Tools > Locks 

and ensure a check mark does NOT exist next to Style.  This will ensure the View Surface 

Contours dialog opens in the next step. 

2. In InRoads, open the command dialog box for Surface > View Surface > Contours…   

WARNING:  If you use a small interval (i.e. 1’) for your contours, InRoads will possibly 

crash (or just take hours to process), especially if you have merged 2 or more DEMs.  It 

is best to start with a larger interval first and then reduce it, if needed.  The interval will 

vary depending on how large or small the watershed elevation differential is. 

3. Load the Preference: Existing.  The interval determines the elevation difference between 

consecutive contours, and the Minors per Major value determines how many contours will 

show up between the Major contours.  For example, an interval of 5’ and a Minors per 

Major value of 4 will show Major Contours every 25’.  If you change the Minors per Major 

value to 9, the Major Contours will show up every 50’ instead.  Note, that these contours 

will all show up regardless, as long as the Minors per Major value is greater than zero; this 

value only affects which contours are assigned the Feature Style (and in turn, the color) 

for Major or Minor Contours.  If the Minors per Major value is set to zero, then you will only 

see the contours at the specified interval.  Now, view the contours of the 

Final_Merged_DEM.  See screen capture below for an example: 

 

4. Once you have a set of contours good enough to determine a new boundary, then create 

a new DGN file and Reference these Contours into this new file. 

5. Create a Complex Shape in this new DGN File of the area you wish to use as your new 

DTM. 
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6. Go back to the DGN File with the Contours and Reference in this new DGN File (which 

will only have the Complex Shape in it). 

7. Delete everything in this file so that it is empty. 

8. View all of the Features of the Final_Merged_DEM. Surface > View Surface > 

Features… 

9. Now create a Fence (by Element) by clicking on the Complex Shape from the Reference 

File. 

10. In InRoads, click on Surface > Edit Surface > Copy Portion of Surface… 

11. Select the Final_Merged_DEM as the Source Surface.  Select Final_Clipped_DEM as 

the Destination Surface.  Choose Fence for the Clip By: field, and Inside for the Fence 

Mode.  Click Apply. 

12. You now have a new, clipped DTM.  It will be easier/quicker to view the Contours of this 

clipped DTM using smaller intervals than using the original DTMs.  If you need to increase 

or decrease the size of the clipped DTM, all you need to do is repeat steps 9-15.  However, 

you will first need to either Empty the Final_Clipped_DEM, or create a new blank Surface 

to serve as the Destination Surface (i.e. Final_Clipped_DEM_new).  Make sure to save 

any unsaved work before attempting to view Contours at small intervals.  Especially for 

larger DTMs (more than one Quad Map), the processing time could be anywhere from a 

few minutes to over 1 hour.  It is good practice to start with larger intervals, gradually 

reducing them to judge how long your computer will take to process viewing Contours. 
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